Autodesk® Inventor® 2018
Working with Imported Data

Student Guide
Mixed Units - 1st Edition
## Contents

Preface ............................................................................................................ iii

In this Guide .................................................................................................. vii

Practice Files .................................................................................................. xi

Chapter 1: Importing CAD Data................................................................. 1-1
  1.1 Importing CAD Data ........................................................................ 1-2
  1.2 Exporting Geometry ........................................................................ 1-6
  1.3 Attaching Point Cloud Data ............................................................ 1-8

Practice 1a Opening a CATIA Assembly............................................ 1-13

Practice 1b Opening STEP Files ............................................................ 1-17

Chapter Review Questions ................................................................... 1-22

Command Summary ............................................................................. 1-24

Chapter 2: Working with Imported Solids ............................................... 2-1
  2.1 Editing the Base Solid .................................................................... 2-2
  2.2 Direct Edit ........................................................................................ 2-6
      Move ................................................................................................. 2-6
      Size ................................................................................................... 2-8
      Scale ................................................................................................. 2-9
      Rotate ............................................................................................... 2-11
      Delete ............................................................................................... 2-13

Practice 2a Direct Edit ........................................................................ 2-15

Chapter Review Questions ................................................................... 2-26

Command Summary ............................................................................. 2-29
Chapter 3: Working with Imported Surfaces .............................................. 3-1

3.1 Importing Surfaces ......................................................................... 3-2
3.2 Repairing Imported Surfaces ......................................................... 3-4
Practice 3a Repairing Imported Data .................................................. 3-13
Practice 3b Manipulating Imported Surfaces .................................... 3-26
Chapter Review Questions ................................................................... 3-30
Command Summary ............................................................................. 3-32

Chapter 4: Importing AutoCAD Data........................................................... 4-1

4.1 Opening AutoCAD Files .................................................................. 4-2
   Opening DWG Files .......................................................................... 4-2
   Importing DWG Files ....................................................................... 4-3
4.2 Working with other Autodesk Product Files ................................ 4-9
   Mechanical Desktop ......................................................................... 4-9
   Alias Studio Files ........................................................................... 4-9
   Autodesk Revit Files ......................................................................... 4-9
   3ds Max Design Files ....................................................................... 4-9
Practice 4a Import an AutoCAD DWG File into Autodesk Inventor ........................................................................................................... 4-10
Practice 4b Open AutoCAD DWG Data to Create a Solid ................. 4-15
Chapter Review Questions ................................................................... 4-21
Command Summary ............................................................................. 4-22

Chapter 5: Working with DWG Underlays .................................................. 5-1

5.1 DWG File Underlays ........................................................................ 5-2
   Importing a DWG File as an Underlay ........................................... 5-2
   Controlling Layer Visibility ............................................................. 5-3
   Moving an Underlay ......................................................................... 5-3
   Cropping an Underlay ...................................................................... 5-4
   Using an Underlay to Create Geometry ........................................ 5-4
Practice 5a Import Associative DWG Data into a Part File ................. 5-8
Practice 5b Associative DWG Layout .................................................. 5-19
Chapter Review Questions ................................................................... 5-29
Command Summary ............................................................................. 5-30

Index .................................................................................................... Index-1
Preface

The Autodesk® Inventor® 2018: Working with Imported Geometry student guide teaches you how to work with data from other CAD platforms using the Autodesk Inventor software.

Using this student guide, you will learn the various methods for importing data into Autodesk Inventor and how you can edit both imported solid and surface data. Additionally, you will learn how to index scanned point cloud data, and attach and use it in an Inventor file. The final chapters in this student guide discuss how you can use AutoCAD .DWG files in the Autodesk Inventor software.

The topics covered in this student guide are also covered in ASCENT’s Autodesk® Inventor® 2018: Advanced Part Modeling student guide, which includes a broader range of advanced learning topics.

Objectives

• Import CAD data into the Autodesk Inventor software.
• Export CAD data from the Autodesk Inventor software in an available export format.
• Index a supported point cloud data file, attach, and edit it for use in a file.
• Use the Edit Base Solid environment to edit solids that have been imported into the Autodesk Inventor software.
• Create Direct Edit features in a model that move, resize, scale, rotate, and delete existing geometry in both imported and native Autodesk Inventor files.
• Set the import options to import surface data from other file format types.
• Transfer imported surface data into the Repair Environment to conduct a quality check for errors.
• Appropriately set the stitch tolerance value so that gaps in the imported geometry can be automatically stitched and identify the gaps that are not stitched.
• Use the Repair Environment commands to repair gaps or delete, extend, replace, trim and break surfaces to successfully create a solid from the imported geometry.
• Open an AutoCAD DWG file directly into an Autodesk Inventor part file and review the data.
• Use the DWG/DXF File Wizard and its options to import files into an Autodesk Inventor file.
• Use an AutoCAD DWG file in an Autodesk Inventor part file so that the geometry created in Inventor remains associative with the AutoCAD DWG file.

Note on Software Setup

This student guide assumes a standard installation of the software using the default preferences during installation. Lectures and practices use the standard software templates and default options for the Content Libraries.

Students and Educators can Access Free Autodesk Software and Resources

Autodesk challenges you to get started with free educational licenses for professional software and creativity apps used by millions of architects, engineers, designers, and hobbyists today. Bring Autodesk software into your classroom, studio, or workshop to learn, teach, and explore real-world design challenges the way professionals do.

Get started today - register at the Autodesk Education Community and download one of the many Autodesk software applications available.

Visit www.autodesk.com/joinedu/

Note: Free products are subject to the terms and conditions of the end-user license and services agreement that accompanies the software. The software is for personal use for education purposes and is not intended for classroom or lab use.
Lead Contributor: Jennifer MacMillan

With a dedication for engineering and education, Jennifer has spent over 20 years at ASCENT managing courseware development for various CAD products. Trained in Instructional Design, Jennifer uses her skills to develop instructor-led and web-based training products as well as knowledge profiling tools.

Jennifer has achieved the Autodesk Certified Professional certification for Inventor and is also recognized as an Autodesk Certified Instructor (ACI). She enjoys teaching the training courses that she authors and is also very skilled in providing technical support to end-users.

Jennifer holds a Bachelor of Engineering Degree as well as a Bachelor of Science in Mathematics from Dalhousie University, Nova Scotia, Canada.

Jennifer MacMillan has been the Lead Contributor for *Autodesk Inventor: Working with Imported Data* since its initial release in 2017.
In this Guide

The following images highlight some of the features that can be found in this Student Guide.

**FTP link for practice files**

**Practice Files**

The Practice Files page tells you how to download and install the practice files that are provided with this student guide.

**Chapters**

Each chapter begins with a brief introduction and a list of the chapter’s Learning Objectives.
1.3 Working with Commands

The main way to access commands in the AutoCAD software is to use the Ribbon. Several of the file commands are available in the FileTabs on the Ribbon (see Figure 1-1). The status bar and the Command Line are used by many AutoCAD commands to display prompts. You can also type the name of a command in the Command Line or instantly select the AutoComplete feature to display the command you need.

**Side notes**

Side notes are hints or additional information for the current topic.

**Instructional Content**

Each chapter is split into a series of sections of instructional content on specific topics. These lectures include the descriptions, step-by-step procedures, figures, hints, and information you need to achieve the chapter’s Learning Objectives.

**Practice Objectives**

Practices enable you to use the software to perform a hands-on review of a topic.

Some practices require you to use prepared practice files, which can be downloaded from the link found on the Practice Files page.

**Chapter Review Questions**

Chapter review questions, located at the end of each chapter, enable you to review the key concepts and learning objectives of the chapter.
Icons in this Student Guide

The following icons are used to help you quickly and easily find helpful information.

Command Summary

The Command Summary is located at the end of each chapter. It contains a list of the software commands that are used throughout the chapter, and provides information on where the command is found in the software.

Command Summary

The following is a list of the commands that are used in this chapter, including details on how to access the command using the software’s ribbon, toolbar, or keyboard commands.

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Close</td>
<td>- Drawing Window - Application Menu - Command Prompt ]</td>
</tr>
<tr>
<td></td>
<td>Close - Drawing Window</td>
<td>- Application Menu - Command Prompt ]</td>
</tr>
<tr>
<td></td>
<td>Close All</td>
<td>- Application Menu</td>
</tr>
<tr>
<td></td>
<td>Dynamic Input</td>
<td>- Status Bar [customization] - Application Menu</td>
</tr>
</tbody>
</table>

*New in 2018*

Indicates items that are new in the Autodesk Inventor 2018 software.

*Enhanced in 2018*

Indicates items that have been enhanced in the Autodesk Inventor 2018 software.
Chapter 1

Importing CAD Data

The Autodesk® Inventor® software supports the import of files from many different types of 3D CAD programs. In some cases, an associative link can be maintained between the source file and the Autodesk Inventor software. Once a CAD file has been imported, the geometry is brought into an Autodesk Inventor file where it can be further manipulated using tools available in the software. Understanding the editing tools that are available to further manipulate the imported geometry is essential to ensuring the efficient creation of the required model.

Learning Objectives in this Chapter

• Import CAD data into the Autodesk Inventor software.
• Export CAD data from the Autodesk Inventor software in an available export format.
• Index a supported point cloud data file, attach, and edit it for use in a file.
1.1 Importing CAD Data

You can import supported file formats simply by opening the files. The Autodesk Inventor software can open the file formats shown in Figure 1–1.

![Files of type](image)

Figure 1–1

How To: Import Data

1. In the File menu or Quick Access Toolbar, select Open. The Open dialog box displays.
2. In the Files of type drop-down list, select the file format that is to be imported.
3. Select the file to import and click Open. The Import dialog box opens.

Hint: Importing into an Existing File

You can import CAD Data into existing files using the following options:

- In an open part file, in the 3D Model tab>create panel, click \( \text{Import} \) (Import). The Import command is also available on the Manage tab>Import panel.
- In an assembly file, in the Assemble tab>expanded Place commands, click \( \text{Place Imported CAD Files} \) (Place Imported CAD Files).
• If a part file is imported, a new Autodesk Inventor part file is created.
• If an assembly is imported, a new Autodesk Inventor assembly is created.
• The available options in the dialog box vary depending on the file format that is being imported.

In the example shown in Figure 1–2, a CATIA part file and an .IGS file were selected, as indicated by the filenames at the top of the dialog boxes.

4. In the Import Type area, select how the data will be imported:
   • Select Reference Model to import the data so that a reference is maintained to the source file. If this option is used, when changes are made to the source file, you can update the model in Autodesk Inventor to reflect the changes.
   • Select Convert Model to import the geometry and break the link with the original model.
5. In the **Object Filters** area, select the data type to import (i.e., Solids, Surfaces, Meshes, Wires, Work Features, or Points).

6. In the **Inventor Length Units** area, specify the type of length unit to use for the imported geometry. The options enable you to maintain the same units as the data being imported (**From source**), or select from a list of standard units (e.g., inch, foot, millimeter, meter, etc).

7. Depending on the **Import Type**, proceed as follows:
   - If the data is being imported using the **Reference Model** option, there are no additional options that are available. Continue to Step 11.
   - If the data is being imported using the **Convert Model** option, continue to Step 8.

8. (Optional) If you are importing a large data set on a system with limited memory, enable **Reduced Memory Mode**. This option enables you to increase memory capacity, at the cost of performance.

9. In the **Assembly Options** and **Part Options** areas, select how the assembly structure and surfaces are to be imported using the drop-down lists. The options vary depending on the file format being imported as follows:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Drop-down List</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parts</strong></td>
<td>Surfaces</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Individual:</td>
<td>Surfaces are brought in individually.</td>
</tr>
<tr>
<td></td>
<td>• Composite:</td>
<td>A single composite feature.</td>
</tr>
<tr>
<td><strong>IGES or STEP files</strong></td>
<td>Surfaces</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Individual:</td>
<td>Surfaces are brought in individually.</td>
</tr>
<tr>
<td></td>
<td>• Composite:</td>
<td>A single composite feature.</td>
</tr>
<tr>
<td></td>
<td>• Stitch:</td>
<td>Automatically stitches surfaces together on import.</td>
</tr>
<tr>
<td><strong>Assemblies</strong></td>
<td>Structure, Surfaces</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assembly:</td>
<td>The original assembly structure is maintained.</td>
</tr>
<tr>
<td></td>
<td>• Multi-body part:</td>
<td>Each component is imported as individual solid bodies in a single part.</td>
</tr>
<tr>
<td></td>
<td>• Composite Part:</td>
<td>Each part in an assembly is a composite.</td>
</tr>
<tr>
<td></td>
<td>• The Part surface options that are available for assemblies are the same as those available for parts.</td>
<td></td>
</tr>
</tbody>
</table>
10. By default, the name of the newly created file that contains the imported geometry is the same as the imported filename. In the File Names area, enter a prefix or suffix to append to the default name in the Name field. Additionally, you can browse to a new directory or accept the default file location for the new file.

11. In the Select tab, click Load Model to add all of the model data to the dialog box and display a preview of the model in the graphics window.

12. (Optional) Click the circular node associated with each node to toggle its inclusion. By default, all nodes are included ( ). When the node is displayed, the geometry is excluded. To toggle multiple surfaces, select them and use the appropriate Status symbol at the top of the Import dialog box.
   - Whether or not you can include or exclude geometry depends on the type of part or assembly that is being imported.

13. (Optional) You can map properties from CATIA, Solidworks, NX, STEP, and Pro-ENGINEER/Creo to standard Autodesk Inventor properties using the Property Mapping option. Select the file type that you want to map the Autodesk Inventor properties to fill the values, as required. Click Save.

14. Once the options are set, click OK to open the imported solid in the Autodesk Inventor software.

**Hint: Additional Information on Importing CAD Formats**

For more details on the specific formats and versions of other CAD software products that are supported for import, search the Autodesk Inventor Help for "To Import Files from other CAD Systems" or "About Importing Files from other CAD Systems".
1.2 Exporting Geometry

To export files, select **Save As > Save Copy As** in the **File** menu. The export file formats that are available for part, assembly, and drawing files are shown in Figure 1–3.

Consider the following when exporting:

- Presentation files can be exported to the following file formats: .DWF, .DWFX, .BMP, .PDF, .PNG, .GIF, .JPG and .TIFF.

- Image files can also be exported by selecting **Export > Image** in the **File** menu.
• Sketches or planar faces can be exported to .DWG or .DXF by right-clicking on a sketch and selecting **Export Sketch As**, or by selecting a planar face, right-clicking on it, and selecting **Export Face As**.

• If you save a file as a .BMP file, a snapshot of the part, assembly, presentation, or drawing file is created as the file displays on the screen.

• SAT files are generally used to translate from a program that uses an ACIS kernel to another. It can also be used to include sketches in the file.

• Sheet metal flat patterns can be exported to .SAT, .DWG, or .DXF formats by right-clicking and selecting **Save Copy As**.

• The .STL file format provides options that enable you to control the facets quality, format, and structure of the file so that an accurate prototype of a part or an assembly file can be sent to a 3D printer.

• The IGES file format enables you to export part geometry and base surfaces and assign them to different layers. Note that only the surfaces visible in the model when exported are included in the exported IGES file.

• Exporting an assembly as a Step file saves all of the files in a single file.
1.3 Attaching Point Cloud Data

In addition to the file formats that can be directly opened/imported into the Autodesk Inventor software, you can also attach a point cloud dataset to a new or existing Autodesk Inventor file.

A point cloud file contains a large number of individual vertices that represent the surface of an object(s). The vertices are generally defined with an X, Y, and Z coordinate. The point cloud file is created by a 3D scanning device and can consist of many different file formats. Once imported, the scanned point cloud file can be used to verify fit and function in a top-level assembly file. Figure 1–4 shows an example of a scanned pump system. This piping system could be brought into an assembly model that contains other details of the design.

Figure 1–4

To attach a point cloud file to an Autodesk Inventor file, it must be first opened in the Autodesk® ReCap software, indexed, and then saved for import into the Autodesk Inventor software.
The point cloud files that can be indexed in the Autodesk® ReCap™ software are shown in Figure 1–5.

**How To: Index a Point Cloud File**

1. In the Manage tab>Point Cloud panel, click (Autodesk ReCap). In the message window that displays, confirm that the Autodesk ReCap software should be launched.
2. Close the Welcome screen.
3. In the top left corner of the interface, select scan project to create a new project file to index the point cloud data.
4. Enter a name for the project. A default path for the project is listed below the project name. Select the default path to open the Browse for Folder dialog box and assign a new folder path.
5. Click proceed once the project name and folder have been confirmed.
6. On the Import files page, select select files to import to open the Import Point Clouds dialog box. Browse to and select a supported point cloud file. Click Open.
7. The scan settings become available to clip points (filtering) or define advanced scan options (csys settings, etc.). Define the options, as required.
8. Select import files in the lower right-hand corner to begin indexing the data.
9. Once the import has completed, the project is saved in the Project directory and the indexed data is saved in the Project directory\<project name> folder as an .RCS file.
10. Select indexed scans in the lower right-hand corner to review the list of scanned data.

11. Select launch project in the lower right-hand corner to open the project in the Autodesk ReCap software. Once opened, you can use additional tools to manipulate and work with the data.

How To: Attach a Point Cloud File in a Model

1. In the Manage tab>Point Cloud panel, click (Attach).
2. In the Select Point Cloud File dialog box, select the indexed file (.RCS or .RCP) to attach. Click Open.
3. Select a location in the Autodesk Inventor file to place the point cloud data. The Attach Point Cloud dialog box opens enabling you to customize the attachment point and rotation values, and to adjust the density, as shown in Figure 1–6.

4. Click OK to attach the point cloud. Once imported, the Model browser updates to include a Point Clouds node that lists the imported file, as shown in Figure 1–7.

Refer to the Autodesk ReCap Help for more information on customizing imported Point Cloud Data.
Once the point cloud data has been imported, you can use the commands in the Point Cloud panel (as shown in Figure 1–8) to work with the data.

![Figure 1–8](image)

- Crop the point cloud data to remove unnecessary data from the file. To crop, click (Box Crop) in the Point Cloud panel and draw a bounding box around the area that is to be kept. Select an arrow on any of the six sides of the bounding box and drag to change the position of its wall or enter an explicit value, as shown in Figure 1–9. Continue to activate each wall and modify its position as required, to create the required bounding box. Click to crop.

![Figure 1–9](image)

- Use the Uncrop command to remove the previous crop operation and return all of the point cloud data to the file. To uncrop, expand the Box Crop command and click (Uncrop) in the Point Cloud panel.

- Open the Point Cloud Navigator dialog box to control the visibility status of any attached point cloud data. To open the dialog box, click (Navigator) in the Point Cloud panel and click next to the data file to toggle its visibility off. Click to toggle its visibility back on. Its visibility can also be toggled off in the Model browser.
• Add a work point to the model by using a point cloud point as a reference. To create a work point on an existing cloud point, click 🌊 (Cloud Point) in the Point Cloud panel and select a point. Work points can be used to create additional geometry in the model.

• Add a Work Plane to the model by using points in the point cloud as references. To create a Work Plane, click 🌊 (Cloud Plane) in the Point Cloud panel and select in the model to create the plane. The plane is inferred from a set of points in the point cloud.
 Practice 1a  Opening a CATIA Assembly

 Practice Objectives

- Open a CATIA assembly file in Autodesk Inventor by referencing the source data.
- Incorporate changes made to the CATIA model in the Autodesk Inventor model.

In this practice, you open a CATIA assembly file using the **Reference Model** option. By importing the CAD data in this way, changes made in the source model update in the Autodesk Inventor assembly. A change in a CATIA model is made, and you will update the change in the assembly. The final model is shown in Figure 1–10.

![Figure 1–10](image)

**Task 1 - Import a CATIA assembly file in Autodesk Inventor.**

1. In the **Get Started** tab>Launch panel, click ![Projects](image) (Projects) to open the Projects dialog box. Project files identify folders that contain the required models.

2. Click **Browse**. In the C:\Autodesk Inventor 2018 Working with Imported Data Practice Files folder, select **Working with Imported Data.ipj**. Click **Open**. The Projects dialog box updates and a check mark displays next to the new project name, indicating that it is the active project. The project file tells Autodesk Inventor where your files are stored. Click **Done**.

3. In the Quick Access Toolbar, click ![Folder](image).

4. In the Open dialog box, navigate to the **SparkPlug** folder in the practice files folder.

5. In the Files of type drop-down list, select **CATIA V5 Files**.
Alternatively, the CATIA assembly could be placed in an existing assembly using **Place Imported CAD Files** on the Component panel.

6. Select **SparkPlug.CATProduct** and click **Open**. The Import dialog box opens.

7. Select **Reference Model** from the **Import Type** area. This assembly is required for use in an Autodesk Inventor assembly model. If changes are made in the source model, the changes must be updated in the Inventor version of the file.

8. In the **Object Filters** area, ensure that only **Solids** is selected. Clear any other options.

9. In the **Inventor Length Units** area, ensure that **From source** is selected. The dialog box updates as shown in Figure 1–11.

![Figure 1–11](image)

10. In the **Select** tab, click **Load Model**. A preview of the CATIA assembly displays in the graphics window and the components of the assembly are listed.

11. Click the circular node associated with the **Wire.1** component to toggle its status to Excluded ( ). Leave all of the other components as Included.

12. Click **OK** to close the dialog box and import the geometry. The assembly is listed in the Model browser, as shown in Figure 1–12.
13. Save the assembly as **Sparkplug.iam** in the **SparkPlug** folder.

**Task 2 - Edit the imported options.**

1. In the Model Browser, right-click on **SparkPlug:1** and select **Edit Import** to open the Import dialog box that was used to import the files.

2. In the **Select** tab, select **adjacent to the Wire.1** component to include it in the imported geometry.

3. Click **OK** to confirm the change. Note that the component is now listed in the Model browser.

**Task 3 - Edit the imported model geometry.**

In this portion of the practice you will simulate making a design change in the original CATIA model. To do this you will rename a file that has been provided to you so that it is used instead of the existing file. This file has had modifications made to it in CATIA. By renaming, you are simulating that the change was made locally to the CATIA file.

1. In Windows Explorer, navigate to your practice files folder and open the **SparkPlug** folder.

2. Select the **Body.CATPart** file and rename it to **Body_OLD.CATPart**.
3. Select the **Body.UPDATED.CATPart** file and rename it to **Body.CATPart**.

4. Return to the Autodesk Inventor software.

5. Note in the Model Browser that the ⚡ icon appears next to the **SparkPlug:1** imported geometry node (it might take a moment to update). In the Quick Access Toolbar, click 🔄 (Local Update) to update the imported geometry with the change that was made in the source model. The model appears as shown in Figure 1–13.

![Figure 1–13](image)

6. In Model Browser, right-click on **SparkPlug:1** and note the **Suppress Link** and **Break Link** options. These options can be used to either temporarily break the link with the source CATIA model (Suppress Link) or permanently break the link (Break Link).

7. Save the file and close the window.
Practice 1b

Opening STEP Files

Practice Objectives

- Open a STEP file in the Autodesk Inventor software.
- Edit the imported STEP data to delete a face, move a face, and change its size.
- Add parametric Autodesk Inventor features to the imported geometry.

In this practice, you open auxpart.stp and edit the solid base model to make changes to the imported data. You also add standard Autodesk Inventor features (fillets) to the model and illustrate that the fillet is parametric although the imported geometry is not. The final model is shown in Figure 1–14.

![Figure 1–14](image)

**Task 1 - Open a part file.**

1. In the Quick Access Toolbar, click .
2. In the Open dialog box, in the Files of type drop-down list, select **STEP Files**.
3. Select auxpart.stp from the top-level practice files folder. Click **Open**. The Import dialog box opens.
4. Select **Convert Model** from the **Import Type** area to import the file.
5. In the **Object Filters** area, ensure that **Solids** is selected. Clear any other options, if required.
6. In the *Inventor Length Units* area, ensure that **From source** is selected.

7. In the *Part Options* area, select **Composite** from the Surfaces drop-down list.

8. Click **OK** to close the dialog box and import the geometry. The geometry is listed as **Base1** in the Model browser, as shown in Figure 1–15. The imported solid is a single feature with no associativity between it and the original file.

![Figure 1–15](image)

**Task 2 - Edit the imported model geometry.**

1. In the Model browser, right-click on **Base1** and select **Edit Solid**. The *Edit Base Solid* tab displays. The panels available provide editing options for imported solids.

2. Select the surface of the hole, as shown in Figure 1–16.

![Figure 1–16](image)

The **Move Face** option enables you to select one or more faces on the imported solid to move them in a specified direction.

3. Right-click and select **Delete** to remove the hole.

4. In the Modify panel, click **(Move Face)**. The Move Face mini-toolbar opens.
5. In the mini-toolbar, expand the drop-down list and select **Direction and Distance**, as shown in Figure 1–17.

6. In the mini-toolbar, the **Faces** option is selected by default. Select the hole face as shown in Figure 1–18.

7. In the mini-toolbar, click **Direction** and select the edge indicated in Figure 1–18 to define the direction for the move. If required, click to flip the direction of the arrow, as shown in Figure 1–18.

8. In the **Distance** field, enter 0.25. Complete the move. The part displays as shown in Figure 1–19.
9. In the Modify panel, click (Extend/Contract Body). This option resizes an imported solid in a direction perpendicular to a selected plane. The Extend or Contract Body dialog box opens as shown in Figure 1–20.

![Figure 1–20](image)

10. Select the face shown in Figure 1–21 as the reference plane for the extension.

![Figure 1–21](image)

11. In the Distance field, enter 2 and click (Expand) to expand the solid part.

12. Click OK. The part displays as shown in Figure 1–22. The imported geometry is extended in length by the specified distance.

![Figure 1–22](image)
13. In the Exit panel, click (Finish Base Solid).

14. Add fillets to the horizontal edges of the model using the default radius value.

15. In the Model browser, right-click on Fillet1 and select Show Dimensions.

16. Set the new Radius to 0.25 and press <Enter>.

17. Update the model to incorporate the dimension change. The part displays as shown in Figure 1–23. Note that the fillet is parametric although the imported geometry is not.

18. Save the part and close the window.
Chapter Review Questions

1. CAD data can only be opened into a new Inventor file. CAD data can not be imported into an existing part file.
   a. True
   b. False

2. Which of the following two Import Type opens should be used to ensure that a link to the source file is maintained and that changes that are made to the imported data can be updated.
   a. Reference Model
   b. Convert Model

3. Which of the statements are true regarding the Import dialog box when importing CAD data from another software package? (Select all that apply.)
   a. If a part file is imported, a new Autodesk Inventor part file is created.
   b. If an assembly is imported, a new Autodesk Inventor assembly is created.
   c. When importing a part into the Autodesk Inventor software, you can set the Part options to recognize each feature as a separate body.
   d. All geometry in the CAD file must be imported. Once imported, you can remove geometry as required.

4. Which of the following menu options enable you to export a .DWG file as a .BMP file? (Select all that apply.)
   a. File menu>Save>Save
   b. File menu>Save As>Save As
   c. File menu>Save As>Save Copy As
   d. File menu>Save As>Save Copy as Template
   e. File menu>Export>Image
5. Which software product should you use to index the point cloud data before importing it into the Autodesk Inventor software?

a. Autodesk® Revit®

b. Autodesk® Inventor®

c. Autodesk® ReCap™

d. Autodesk® Alias®

Answers: 1.b, 2.a, 3.(a,b), 4.(c,e), 5.c
## Command Summary

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ReCap" /></td>
<td>Autodesk ReCap</td>
<td>• <em>Ribbon: Manage tab&gt;Point Cloud panel</em></td>
</tr>
<tr>
<td></td>
<td>Export Face As</td>
<td>• <em>Browser: right-click a face</em></td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td>Export Image</td>
<td>• <em>File menu: Export</em></td>
</tr>
<tr>
<td></td>
<td>Export Sketch As</td>
<td>• <em>Browser: right-click a sketch</em></td>
</tr>
<tr>
<td><img src="image" alt="Import" /></td>
<td>Import</td>
<td>• <em>Ribbon: 3D Model tab&gt;Create panel</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Ribbon: Manage tab&gt;Import panel</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Ribbon: Assemble tab&gt;expanded Place commands</em></td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open</td>
<td>• <em>Ribbon: Get Started tab&gt;Launch panel</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>Quick Access toolbar</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <em>File menu</em></td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Save Copy As</td>
<td>• <em>File menu: Save As</em></td>
</tr>
</tbody>
</table>